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ABSTRACT 
 
Intraneural Ganglion Cysts expand within in a nerve, causing neurological deficits in afflicted 

patients.  Modeling the propagation of these cysts, originating in the articular branch and then 

expanding radially outward, will help prove articular theory, and ultimately allow for more 

purposeful treatment of this condition.  In Finite Element Analysis, traditional Lagrangian 

meshing methods fail to model the excessive deformation that occurs in the propagation of these 

cysts.  This report explores the method of manual adaptive remeshing as a method to allow for the 

use of Lagrangian meshing, while circumventing the severe mesh distortions typical of using a 

Lagrangian mesh with a large deformation.  Manual adaptive remeshing is the process of 

remeshing a deformed meshed part and then reapplying loads in order to achieve a larger 

deformation than a single mesh can achieve without excessive distortion.  The methods of manual 

adaptive remeshing described in this Master’s Report are sufficient in modeling large 

deformations. 
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1  Introduction 
 
1.1 Intraneural Ganglion Cysts 

Intraneural Ganglion Cysts (IGC) often occur in the common peroneal nerve (CPN), resulting in 

muscle weakness, sensory abnormalities, and pain (Elangovan, 2010).  The purpose of this study is 

to investigate methods of manual adaptive meshing using the computational tool of finite element 

analysis (FEA) that can be used to further explore the pathogenesis of these cysts.  This will 

ultimately allow clinicians to understand how these cysts are formed and propagate, allowing for 

more effective treatment methods and preventing the spread and reccurance of these cysts.   

1.1.1 Intraneural Ganglion Cysts in the Common Peroneal Nerve 

Intrneural ganglion cysts (IGC) are the mucinous lesions found within the nerve epineurium, as  

described in more detail in the typical anatomy of a nerve in the following section.  They are most 

commonly found in the common peroneal nerve (CPN), but can also be found in other nerves near 

joints producing synovial fluid (Elangovan 2009). 

1.1.2  Nerve Anatomy and Intraneural Ganglion Cysts 

A typical nerve structure can be seen in Figure 1.1.  The nerve is enclosed by the outer epineurim, 

which is mainly composed of connective tissue (Elangovan 2009).  The inner epineurium, 

composed primarily of loose connective tissue, serves to protect the embedded fascicles.  These 

fascicles are comprised of bundles of axons, which consist of nerve fibers that provide the 

electrical pathway for communication between the muscles and the brain.  As a intraneural 

ganglion cyst expands radially in the nerve, the weak tissue in the inner epineurum is easily 

displaced.  As a result, the fascicles are compressed, causing a neurological deficit in affected 

patients as seen in Figure 1.2 (b). 
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Figure 1.1  Typical Nerve Anatomy (Elangovan 2009) 

Figure 1.2 Cross–Section of a Normal Nerve (a)  and  Nerve afflicted with IGC (b) (Elangovan 
2009) 

 

1.1.3  Articular (Synovial) Theory 

The articular (synovial) theory explains the the pathegenesis of intraneural ganglion cysts.  This 

theory suggests that increased intraarticular forces within a nerve near a joint, stemming from joint 

fluid production and axial loading, cause the formation and propagation of the intraneural cyst.  

The intraneural ganglion cyst originates in the articular branch and typically propagates into the 

common peroneal nerve.   

In more detail, the intraneural ganglion cyst originates at the joint-joint capsule interface 

seen in the normal knee joint in Figure 1.3, where joint fluid is produced.  This fluid can then 

escape through an assumedly preexisting capsular defect and enter the articular branch as a result 

of increased intraarticular pressure.  This pressure can then increase from the continued production 
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of synovial fluid at the joint, or as a result of the dynamic pressure from the loadings at the joint.  If 

the intraarticular pressure is greater than the resisting exterior forces, the cyst expands and extends 

in length as a result of the relatively weak neural tissue.  Likewise, the cyst can expand into the 

parent nerves, or smaller branches if there is a blockage (Elangovan 2009).    The propagation of 

the IGC from the articular branch to the sciatic nerve (Phase III)  is illustrated in Figure 1.3.  The 

cross sectional strain due to the deformation of the fascicles during IGC growth  is greater than 

100% (Soman 2011). 

 

Figure 1.3  Propagation of Cyst (from Normal to Phase III) (Elangovan 2009) 

Use of the mechanical modeling suggested in this report can be used to further support the articular 

theory of intraneural ganglion cyst formation.  While this model uses the common peroneal nerve 

since it is the most commonly affected nerve, the mechanical modeling and resulting explanation 

at this location can be applied to other nerves.  As cross sectional engineering strain in the 

two-dimensions is expected to be greater than 100%, advanced numerical techniques are required 

(Soman 2011).   
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Articular theory is supported by images of Magnetic Resonance Imaging  (MRI) cross 

sections at the fibular neck, which indicate cyst propagation originating at the articular branch 

(Soman 2011).   Resulting finite element model analyses resembling this image further support this 

theory.  An example of an affected nerve can be seen in Figure 1.4, with a developed IGC indicated 

by the white arrow in the image.  . 

 

Figure 1.4 MRI of Cross Section of Affected Nerve at Fibular Neck (Soman 2011) 
 

1.2 Previous Work on the Mechanical Modeling of IGC and Meshing Methods 

Soman’s recent thesis included a literature review of large deformation using finite element 

methods (FEM) (Soman 2011).  Several points in Soman’s work are particularly pertinent to the 

work in this report.  Firstly, it was found that typical Lagrangian FEA methods only allows for a 

19% engineering strain before the mesh is insufficient (2011).  Additionally, the advantages and 

disadvantages of using Lagrangian and Eulerian Meshes to model ganglian cyst propagation in the 

CPN were also explored in Soman’s work.  In the Lagrangian mesh, the material coordinates of the 

nodes move with the material, and likewise the material moves along with the mesh.  
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Unfortunately, since mesh and material move together, if large deformation occurs in the material, 

the mesh also encounters large deformation, and the mesh is therefore distorted severely.  

Advantageously, boundary nodes remain on boundaries, making boundary conditions and loads 

easier to apply.  However, Lagrangian meshes are ill suited for large deformation problems, such 

as the large deformation that occurs in the formation of the IGC, as large mesh distortion occurs 

with the large deformation.  Figure 1.5 illustrates such deformation. 

                     

 
Figure1.5  Illustration of Mesh Distortion in Typical Lagrangian Mesh 

 
Furthermore, Soman’s work explored  two two-dimensional meshing methods:  Element Free 

Galerkin Method, a meshless method, and Eulerian Meshing, which uses a fixed background 

mesh.   These methods resulted in engineering strains of 8.60 and 6.82 (or true strains of 2.26 and 

2.06), respectively.  For two-dimensional methods, Elangovan’s work assumed local material 
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failure instead of extensive hyperelastic deformation, since traditional FEA methods only allowed 

for maximum of 19% engineering strain (2010).    

1.3  Manual Adaptive Remeshing 

One method unexplored in the modeling of the intraneural ganglion cyst propagation is the use of 

manual adaptive remeshing.  Finite element modeling programs, specifically ABAQUS, are 

equipped with adaptive meshing tools.  These tools appear to be ineffective for this application  

when modeling a deformation having an engineering strain greater than 100%.  Alternatively, 

manual adaptive remeshing has potential as a method to bypass the severe mesh distortions 

associated with large deformations, allowing Lagrangian meshing to feasibly be used in large 

deformation applications.  It should be noted that ABAQUS refers to manual adaptive remeshing 

as the process of manually modifying adaptive meshing tools (Dassault Systèmes, 2009, (3)).  

However, in the context of this report,  manual adaptive remeshing is described as follows.   

Manual adaptive remeshing is the process of remeshing a deformed part in a Lagrangian 

meshed part and then reapplying loads in order to achieve a larger deformation than a single mesh 

can achieve without excessive mesh distortion.  The basic concept of manual adaptive remeshing 

is an iterative process described in the following steps. 

1.  Create Lagrangian mesh on part (Figure 1.6 (a)). 

2.  Deform part and mesh such that mesh is not excessively distorted.  As discussed, in Lagrangian 

meshes, the material moves along with the mesh (Figure 1.6 (b)). 

3.  Remove mesh and remesh part (Figure 1.6 (c)). 

4.  Apply new loads and boundary conditions on remeshed, deformed part. 

5.  Repeat Steps 2 through 4 until desired deformation and strain are reached (Figure 1.6 (d), (e), 

and (f)). 
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The final deformation will not be a result of the of the summation of the loads from all of 

the iterations since the nerve material is not linearly elastic, but for simplicity and functionality is 

modeled so.  The final total deformation of the intraneural ganglion cyst is of primary concern, 

while the pressures causing the deformation are secondary.  The steps in manual adaptive 

remeshing are displayed graphically as follows in Figures 1.6 (a) through (f). 

(a) Original Meshed Part   

(b) Deformed Mesh  

(c) Remeshed Part (First Remeshing) 

(d) Deformed, Remeshed Part (Second Deformation) 

(e) Remeshed Part (Second Remeshing) 

(f) Deformed, Remeshed Part (Third Deformation) 

 
(a)                                                             (b) 

 
(c)           (d) 
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 (e)                                               (f) 

 

Figure 1.6 (a) through (f) Steps in Manual Adaptive Remeshing 

 

 
(a)                                                                       (b) 

 
Figure 1.7 Mesh distortion (a) with and (b) without Manual Adaptive Remeshing 

 
Figure 1.7 illustrates the final comparison of relatively undistorted mesh (a) with use of manual 

adaptive remeshing and a highly distorted mesh (b) with typical Lagrangian meshing and large 

strains.   
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2.  Objective and Significance 

2.1 Objective 

The objective of the research in this report is to explore and to devise methods of manual adaptive 

remeshing using FEA and then evalutate their abilities to simulate the path of cyst propagation in 

the two-dimensional cross section of the common peroneal nerve.  

2.2  Significance 

This work will give the opportunity for more accurate and appropriate modeling of IGC 

propagation and its associated high deformation.  This can lead to a better understanding of the 

pathogenesis of IGC and ultimately lead to improved treatments based on more accurate 

understanding.   
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3.   Finite Element Model of  Affected Nerve Cross Section  

This report focuses on a two-dimensional model, which can simulate the evolution of an 

intraneural ganglion cyst in a nerve cross section, particularly the common peroneal nerve, with 

results that can be applied to other nerves. The finite element model of the affected CPN cross 

section was created by importing a sketch from Puneet Soman’s work (2011), which was based on 

the real geometry and experimental data of the CPN at the fibular neck in Elangovan’s work 

(2010).  The finite element model used in this report is a two-dimensional planar shell using plane 

stress elements.  The articular branch is modeled as a hole, with the rest of the CPN modeled as a 

homogeneous continuum.  As described previously in articular theory, it is assumed that the 

intraarticular pressures in the articular branch account for the cyst propagation.  Therefore, in this 

model, an internal radially outward pressure is applied in the hole.  The purpose of this pressure is 

to model the propagation of the cyst, originating in the articular branch and growing from normal 

to Phase III.  The articular branch is located from a drawing of the histological section of the sciatic 

nerve at neck of fibula created by Sunderland and Ray seen in Figure 3.1 (Sutherland and Ray, 

1948).  Additionally, the diameter of the cyst is taken to be 0.18 mm, consistent with data from 

clinicians (Soman 2011).   The cross section model with dimensions is seen in Figure 3.2. 

 
 

Figure 3.1 Drawing of Histological Section of Sciatic Nerve at Neck of Fibula (Sunderland and 
Ray, 1948) 
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Figure 3.2 Cross Section Model of Nerve with Articular Branch Hole 
 

Similarly, the model used in this report carries over the assumptions from Soman’s model.  For 

modeling simplicity, a homogenous material is used for the entire area instead of individual 

fascicles and surrounding epineurium.  The material is assumed to be linear elastic, which helps 

model the most important parameter of strain, even though in reality the materials in the CPN are 

anisotropic and nonlinear.  The chosen material is that of the nerves of the carotid artery, which is 

similar to the CPN.  This corresponds with a compressible linear elastic material with a module of 

elasticity of 4.6 MPa and  Poisson's ratio of 0.3.   In reality, the nerve is an incompressible 

hyperelastic material that is anisotropic and nonlinear.  However, since the primary object of this 

finite element model is to be able to mechanically model the strain, and not stresses, the material 

models are of lower importance.  The choice of compressible, linear, elastic, isostropic material 

model allows for modeling simplicity with the ability to still achieve the model’s goal of strain.   

It should be noted that the location of the cyst is placed farther away from the edge of the 

nerve than indicated in Figure 3.1.  The location of the articular branch is located by the rough 
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sketch in Figure 3.1, which does not appear to be a highly precise representation of location.  With 

this said, the exact location of the cyst in the model is not crucial.  Additionally, placing the cyst 

closer to the center of the nerve allows for greater expansion of the cyst overall, which will allow 

this model to  further explore the various methods of manual adaptive remeshing.   
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4.  Methods 

4.1  Overview  of Adaptive Meshing Methods  in ABAQUS  

ABAQUS offers several methods to alleviate problems with meshing during an analysis.  These 

methods are called adaptive meshing methods.  Adaptivity refers to these adaptive processes that 

ABAQUS uses to adapt a mesh to meet the needs of a particular analysis.  The three types of 

adaptive meshing techniques included in ABAQUS 6.9 include Abitrary Lagrangian Eulerian 

adaptive meshing, adaptive remeshing, and map-to-map solution meshing (Dassault Systèmes, 

2009, (1)). 

Arbitrary Lagrangian Eulerian (ALE) adaptive meshing is a method that smoothes a single 

mesh throughout a step in order to control mesh distortion (Dassault Systèmes, 2009, (1)).  A 

single mesh is inappropriate for strains greater than 100% as in the IGC as this would lead to large 

distortions to the mesh (Elangovan 2010).   

 Adaptive remeshing is an automatic remeshing between runs in ABAQUS that improves 

accuracy using multiple meshes, but does not help mitigate mesh distortion.  It is therefore 

inappropriate for this large deformation analysis (Dassault Systèmes, 2009, (1)). 

 Of these automatic remeshing methods, mesh-to-mesh solution mapping appears to be the 

most appropriate for this application and is similar to the manual adaptive meshing explored in this 

report.  Mesh-to-mesh mapping is a method using multiple meshes to reduce mesh distortion. It 

automatically interpolates variables from the old mesh to a new mesh between steps.  

Discontinuities will occur in the solution, and an additional step is required to address this 

discontinuity (Dassault Systèmes, 2009, (1)).  This option does not appear to be suitable due to the 

errors and discontinuities that will occur, but may be explored further outside the context of this 

report.   
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In summary, as these automatic adaptive meshing methods are deemed inappropriate for 

modeling of the IGC, manual adaptive remeshing methods are explored.   

4.2 Manual Adaptive Remeshing Methods 

4.2.1  Manual Adaptive Remeshing Overview 

ABAQUS/CAE User’s Manual refers to “Manual Adaptive Remeshing” as manually editing or 

manipulating the meshes using the adaptive meshing tools available in ABAQUS (Dassault 

Systèmes, 2009, (3)).  In this report, manual adaptive remeshing refers to manually remeshing 

without use of tools in ABAQUS.  In this context, manual adaptive remeshing has promise as a 

method to bypass the severe mesh distortions associated with large deformations, allowing 

Lagrangian meshing to feasibly be used in large deformation applications.  Manual adaptive 

remeshing is the process of remeshing a deformed meshed Lagrangian part and then reapplying 

loads and boundary conditions in order to achieve a larger deformation than a single mesh can 

achieve without excessive mesh distortion or errors.   

4.2.2  Exporting Deformed Meshes 

Without programing, the deformed, post-analysis part can only accessed though the *.odb (output 

database) files or exported from the visualization screen.  A deformed mesh can be exported from 

the visualization screen as a *.vrml or *.3dxml file, which can be opened and viewed, but not  be 

easily converted into other geometry file types, such as part files. 

4.2.3  Orphan Mesh 

Deformed parts can easily be imported as a part back into ABAQUS.  However, this imported part 

is in the form of an orphan mesh, which means that it contains no geometry and is dependent on its 

deformed mesh.  This is done by running the analysis (in the form of a job in ABAQUS) and then 

importing the deformed orphan mesh from the .odb file associated with that job.  There is no 
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geometry with an orphan mesh, so the mesh cannot be removed from the part.  Therefore, the mesh 

cannot be removed  or altered without also removing or altering the part. This mesh can be 

manually redrawn within ABAQUS, but that would be both tedious and create nonuniform 

meshes.  If a triangular mesh is used, the orphan mesh can be modified by changing the lengths of 

element edges, removing some of the distortion in the meshes.  This method is explained in further 

detail in Section 5 Using Iterative Triangular Mesh Refinement for Large Deformation in 

ABAQUS.  Detailed instructions on how to import a deformed orphan mesh from an output 

database file can be found in both Appendix A and Appendix B.   

4.2.4  Iterative Loading 

Iterative loading is used in this report by applying loads and boundary conditions, running an 

analysis, then importing a deformed mesh, reapplying loads and boundary conditions, and 

repeating these steps.  It appears that iterative loading allows for greater deformation without 

meshing distortion than a single equivilant larger load, but does not allow for the deformation 

required to model the IGC.  As a result, it is neccesary for some form of remeshing within these 

iterations.   

4.2.5  Converting Orphan Mesh to Geometry 

Python is the computing language used by ABAQUS.  The python command 

“Part2DGeomFrom2Dmesh”  converts a 2-D mesh to a 2-D part with geometry (Dassault 

Systèmes, 2009, (2)).  This command allows ABAQUS to extract 2-D geometry from orphan 

mesh, which contains no geometry, and creates a new meshless geometric part.  This option is 

explained in greater detail in Section 6 Using Iterative Remeshing by Creating a Geometric Model 

from a Deformed Orphan Mesh to Allow for Large Deformation in Abaqus.   
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5. Using Iterative Triangular Mesh Refinement for Large Deformation in ABAQUS  

5.1 Overview of Method 

In ABAQUS 6.9, if a planar, triangular mesh is used, the mesh can be refined to have a specified 

global element size, even for an orphan mesh without geometry.  This refinement is not available 

for quandrangular meshes.  Triangular meshes are unstructured  and cannot be used with 

subdividing, edgeloops, and smoothing.  Triangular meshing is therefore used with free meshing.  

The element type used in this case is a 2-D triangular mesh, CPS3, a 3 node linear  plane stress 

element.  Therefore, it is possible to iteratively deform a part, import the deformed part from the 

output database (*.odb file), refine the mesh without removing the mesh, and redeform the mesh, 

repeating these steps until the desired deformation is obtained.  During each analysis step, if 

excessive deformation occurs, it is necessary to repeat the analysis step using a lower pressure 

applied to the cyst.  Likewise, the user must use his judgement and increase the load if more 

deformation can occur without mesh distortion.  In a similar fashion, user discretion must be 

applied to select an appropriate mesh size and locations of the fixed node set. 

5.2 Steps in Method 

While detailed intructions are provided in Appendix A for use in future work, a summary of these 

steps is included as follows.   

Basic Steps in Using Iterative Triangular Mesh Refinement for Large Deformation  ABAQUS 6.9 

1. Create two dimensional part as described in Section 3 using a sketch of the CPN.   
• Create appropriate material properties, section properties, analysis steps, and 

instances as described previously.  Mesh part using element type CPS3.   
1. Run job and import deformed *.odb file from job.   
2. Delete extra sets created in orphan mesh. 
3. Refine Mesh. 

• Select Mesh>Edit 
• Select Refinement for the Category and Set Size for the Method.   
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• Select a new mesh size.  In this case, 0.1 was used. 
• Select Remesh for the method.  Remesh part.   

4. Edit node set and surface. 
Since the mesh has been altered, the node set and surface are no longer valid and must 
be edited.   

• Edit node set and select two nodes on the right hand edge of the part.  
• Edit surface set and select element surface of cyst. 

5. Section assignment 
• Make section assignment of nerve material to new part in its entirety.   

6. Instance 
• Create a new instance on new part. 

7. Edit Boundary Conditions and Loads with appropriate instances. 
• Instances must be selected from current part for both fixed boundary condition and 

loads. 
• Loads may need to be decreased if deformation is too great.   

8. Create a new job. 
• Run job. 

9. Repeat steps 2  through 9 from the iterative steps until desired deformation is achieved.   
 

5.3 Results 

5.3.1 Results from Iterative Steps 

The following images seen in Figures 5.1-5.11 show the results of the iterative process of 

importing an orphan mesh, refining meshing, reapplying loads, and creating a new deformed 

mesh.  The model used is described in Section 3 and 5.1.   A pressure loading of 2 MPa was used 

until deformation was too great in Job-7, part named, “Part 1111111.”  At this point, a pressure 

loading of 0.1 MPa was used in the analysis step.  The mesh element size in each step was set at 0.1 

mm.  It should be noted that in this report, a job output database file (job-#.odb) and resulting 

orphan mesh are both used in Figures 5.2-5.10, with the deformed job visualization shown in light 

green and the orphan mesh part shown in dark green.  The naming procedure was used for the parts 

and explanation of associated analysis jobs is described in Table 5.1. 

 

Table 5.1  Table Explaining Iterative Part Names and Associated Jobs 
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Part Name Job Name Using Part Extracted from which *.odb file 

Nerve Job-1 N/a (created from part) 

Part 1 Job-2 Orphan mesh from Job-1.odb 

Part 11 Job-3 Orphan mesh from Job-2.odb 

Part 111 Job-4 Orphan mesh from Job-3.odb 

Part 1111 Job-5 Orphan mesh from Job-4.odb 

Part 11111 Job-6 Orphan mesh from Job-5.odb 

Part 111111 Job-7 Orphan mesh from Job-6.odb 

Part 1111111 Job-8 Orphan mesh from Job-7.odb 

 

 

 
Figure 5.1: Initial Undeformed Nerve and Cyst Part 
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(a) 

  
(b) 

Figure 5.2: Job-1.odb First Deformed Part(a) and Remeshed Part (b) 
 

 
(a) 
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(b) 
Figure 5.3 Job-2.odb Second Deformation Results (a) and Remeshed Part (b) 

 

    
(a) 

 
(b) 

Figure 5.4  Part 111 as Orphan Mesh from Third Deformation (a)  and Remeshed (b) 
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(a) 

 

 
(b) 

Figure 5.5 Part 1111 as Orphan Mesh from 4th Deformation (Job-4) (a)  and Remeshed (b) 
 

   
(a) 
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(b) 

Figure 5.6 Part 11111 as Orphan Mesh from 5th Deformation (Job-5) (a)  and Remeshed (b) 
 

 
Figure 5.7 Sixth Deformation using 2 MPa Pressure Loading from Job-6 

 
 

   
(a) 
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(b) 

Figure 5.8  Part 111111 (6) as Orphan Mesh from a Rerun of Analysis of Job-6 using a Pressure 
Loading of 0.1 MPa (a)  and Remeshed (b) 

 

   
(a) 

 
(b) 

Figure 5.9  Part 1111111 (7) as Orphan Mesh from 7th Deformation (Job-7) (a)  and Remeshed (b) 
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 The seventh deformation from Figure 5.9  is considered the limit in this analysis as even small 

applied pressures, such as 0.1 MPa in Job-8 as seen in Figure 5.10, still caused deformation similar 

to an aneurysm.  This limit is further discussed in Section 5.4.   

 
Figure 5.10 Limiting Aneurysm Deformation  

 
5.3.2 Total Strain 

The final deformed cyst can be approximated as an ellipse.  Using the query tool, it was found that 

the approximate vertical length of the cyst, the major diameter, is 2.34 mm and the horizontal 

length of the cyst, the minor diameter, is 2.30 mm.  This results in an approximate circumference 

of 7.28 mm.  Additionally, the initial undeformed cyst was drawn with a cross sectional radius of 

0.09 mm, meaning the initial circumference of the cyst is 0.5655 mm.  True strain is often 

measured for large strains, and the equation for this strain caused by the cyst propagation in the 

nerve cross section is given by Equation 5.1.   

Strain = ln( Cd/C )        Equation 5.1 

Where 

Cd = Circumference of the deformed cyst 

C = Circumference of the cyst before deformation 

Strain = ln(7.28mm/0.5655mm) = 2.56 

Therefore, the true strain obtained using manual adaptive remeshing is 2.56.   
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5.4 Discussions and Conclusions 

This method of Using Iterative Triangular Mesh Refinement for Large Deformation in ABAQUS  

proves to be an effective and simple method of modeling the propagation of an IGC.  The initial 

model and final propagation are shown in Figure 5.11. 

    
(a)                                                 (b) 

Figure 5.11  Initial Triangular Mesh FE Model (a) and Final Iteration of Triangular Mesh FE 
Model (b) 

 
However, this method can only be used with triangular elements, and therefore only with a free 

mesh and not with a structured mesh, which may be desired for the nerve cross section geometry.  

User discretion must be used to decide the allowable pressure per iterative step and the appropriate 

mesh size to be used per step.  A 2.56 true strain was obtained using this method over seven 

iterations, which is greater than the true strain of 2.26 and 2.06 achieved in Soman’s previous work 

of a meshless method and Eulerian method, respectively.  A comparison with the desired final 

shape in an IGC afflicted nerve MRI  (a) and the final deformation of  in the FEM using Iterative 

Triangular Mesh Refinement (b) is shown in Figure 5.12.  Similarities can be seen between these 

images, particularly in the left hand side of the FEM model and the white cyst depicted in the MRI, 

apparent in the ballooning cyst encased by a fine strip of nerve material.  It is presumed that  more 

realistic constraints based on the actual geometry of the knee anatomy would lead to a final 

deformed shape more consistent with the MRI.  Additionally, more iterations using much smaller 

pressure loadings and finer mesh size would presumably lead to greater expansion of the cyst with 
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a thinner section of nerve material outlining the cyst on the right side of the model.  A limit is 

described in Section 5.3.1, being the approximate final deformation given the current model 

without further refinement, as this final deformation acheives the goal of this report of a method 

exploration.  However, these improvements are not within the scope of this report as the ultimate 

intent of this research is to explore this method as an option.   

 
  (a)       (b) 
Figure 5.12  Cross sections of Afflicted IGC Nerve MRI (a) and Propagated Cyst in FEM using 

Iterative Triangular Mesh Refinement (b) 
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6. Using Iterative Remeshing by Creating a Geometric Model from a Deformed Orphan 
Mesh to Allow for Large Deformation  

 
6.1 Overview of Method 
This method of manual adaptive remeshing in ABAQUS uses the command 

“Part2DGeomFrom2Dmesh” to create a new geometric part from a deformed orphan mesh part 

imported from an output database from a previous analysis job.  This method can be used with any 

two-dimensional planar element as a method to abstract geometry from an otherwise 

geometry-free orphan mesh imported as a deformed part from the output database file.  The 

element type used in this case is CPS4R, a 4-node bilinear plane stress quadrilateral, reduced 

integration, hourglass control element, which is the standard plane stress element in 

two-dimensions in ABAQUS 6.9.  Using this command, it is possible to iteratively allow for large 

deformation using the following steps:  apply a load and boundary conditions and deform a part, 

import this deformed part as an orphan mesh from the output database file, create a new geometric 

part without any mesh from the deformed orphan mesh, remesh this part and apply loads and 

boundary conditions, and repeat this process.  During each analysis step, if excessive deformation 

occurs, it will be necessary to repeat the analysis step using a lower pressure applied to the cyst.  

Likewise, the user must use his judgment and can increase the load if more deformation can occur 

without mesh distortion.  User discretion is required to select appropriate mesh size and locations 

of the fixed node set.  An overview of this overall procedure type is explained in Figures 6.1-6.3.  

In Figure 6.1, Geometric Part A is shown (a) and then remeshed (b).  A pressure loading is applied 

in the cyst in Part A and the deformed imported orphan mesh is new Part B in Figure 6.2.  A 

geometric copy of Part B is made and named Part C in Figure 6.3 (a).  Finally, Part C is remeshed 

in Figure 6.3 (b) and this process is repeated.   
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(a)                                    (b) 

Figure 6.1 Original Geometric Part A (a) and Remeshed Part A (b) 
 

 
Figure 6.2  New Part B imported from deformed Part A 

 

 
Figure 6.3 Geometric copy of Part B named Part C (a) and Meshing of Part C (b) 

 

6.2 Steps in Method 

While detailed intructions are provided in Appendix B for use in future work, a summary of these 

steps is included as follows: 

Basic Steps in Using Iterative Remeshing By Creating a Geometric Model from an Orphan Mesh 
to Allow for Large Deformation in  ABAQUS 6.9 
 

1. Create a Part 
• Create a two dimensional planar part using a sketch of the CPN and cyst 

with radius of 0.09 mm.   
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• Create a geometric node set for fixed points and surface for pressure loads.    
• Create appropriate material properties material properties, section 

properties, analysis steps, and instances as described in Section 3.   
• Mesh part using any 2D plane stress element, in this case element CPS4R 

was used.  
2. Run job and import deformed *.odb file from job.   
3. Create 2D Geometry from Orphan Mesh Part 

• Click on the command window at the bottom of the screen.   
• Type the following in the command line: 

NewPart=mdb.models[‘Model-1’].parts[‘NERVE-1’] 
GeoDef1=mdb.models[‘Model-1’].Part2DGeomFrom2DMesh(name = 
‘GeoDef1’,part=NewPart,featureAngle=0) 

 
Where “Model-1” is the name of the model, “NERVE-1” is the name of the orphan meshed 
part, and “GeoDef1” is the name of the new geometric part being created from the 
meshed part.   

 
4. Use new geometric part to create a new analysis. 

• Create a new cyst surface on the cyst hole. 

• Seed and Mesh Part  

• Add Section Assignment 

• Create New Instance on new part 

• Edit Region for Load to Fixed Node Set for New Part 

• Edit Region for Load to Cyst Surface for GeoDef1 

• Create new job and submit job. 

5. Repeat Steps 3 and 4 until desired deformation is reached.   

• In this process, it is important to select appropriate instances and parts when 

importing *.odb files and applying loads and boundary conditions to parts.   

• Rough rules for deformation per step included a maximum cyst diameter increase of 

50% and a  minimum of 3 elements per section thickness.  
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6.3 Results 

6.3.1 Results from Iterative Steps 

The following images are seen in Figures 6.4-6.21 show the results of the iterative process 

described in Sections 6.1 and 6.2.  The convention for naming parts used in this report is as 

follows.  The orphan mesh of the deformed part from the output database file (*.odb) is 

automatically saved as the part name in capital letters plus a “-1.”  Using the script described 

previously, in this report each geometric part extracted from the orphan mesh is named GeoDef1, 

GeoDef2, etc.  The naming procedure was used for the parts and explanation of associated analysis 

jobs is described in Table 6.1.  The images from all of these geometric parts and some examples of 

the deformed meshes and orphan meshes are shown in Figures 6.4 through 6.20.   

 

Table 6.1 Table Explaining Iterative Part Names and Associated Jobs 

Geometric 
Part Name 

Job Name on 
part creating 
orphan mesh 
part 

Load 
Applied in 

Job 
Analysis 

Global 
Element 
Size of 
Mesh 

Corresponding 
Deformed Orphan 
Mesh Part from 
*.odb file 

Nerve Job -1 1.0 MPa 0.1 mm NERVE-1 
GeoDef1 Job-2 1.0 MPa 0.1 mm GEODEF1-1 
GeoDef2 Job-3 1.0 MPa 0.05 mm GEODEF2-1 
GeoDef3 Job-4 1.0 MPa 0.05 mm GEODEF3-1 
GeoDef4 Job-5 1.0 MPa 0.05 mm GEODEF4-1 
GeoDef5 Job-6 1.0 MPa 0.05 mm GEODEF5-1 
GeoDef6 Job-7 1.0 MPa 0.05 mm GEODEF6-1 
GeoDef7 Job-8    0.5 MPa 0.05 mm GEODEF7-1 
GeoDef8 Job-9 0.5 MPa 0.05 mm GEODEF8-1 
GeoDef9 Job-10 0.5 MPa 0.05 mm GEODEF9-1 
GeoDef10 Job-11 0.2 MPa  0.05 mm GEODEF10-1 
GeoDef11 Job-12 0.2 MPa 0.05 mm GEODEF11-1 
GeoDef12 Job-13 0.2MPa 0.05 mm GEODEF12-1 
GeoDef13     
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(a)     (b) 

Figure 6.4 Initial “Nerve” Part in Geometric Form (a) and Meshed (b) 
 

        
(a)     (b) 

 
(c) 

Figure 6.5 Orphan Mesh Part “NERVE-1”from Job-1 Output Database File (a), Corresponding 
Geometric Part “GeoDef1” (b,) and “GeoDef1” Remeshed (c) 

 
At this point, after the Job-2 analysis, the mesh size was decreased from 0.1 mm to 0.05 mm to 

prevent propagation of coarse mesh geometry throughout the further deformation steps.   
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(a)                                                (b) 

 

 
(c) 

Figure 6.6  Orphan Mesh Part “GEODEF1-1”from Job-2 Output Database File (a), 
Corresponding Geometric Part “GeoDef2” (b,) and “GeoDef2” Remeshed (c) 

 
 

    
(a)     (b)  

 
      (c) 
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Figure 6.7  Orphan Mesh Part “GEODEF2-1”from Job-3 Output Database File (a), 
Corresponding Geometric Part “GeoDef3” (b,) and “GeoDef3” Remeshed (c) 

 
 

       
(a)      (b) 

 
(c) 

Figure 6.8  Orphan Mesh Part “GEODEF3-1”from Job-4 Output Database File (a), 
Corresponding Geometric Part “GeoDef4” (b), and “GeoDef4” Remeshed (c) 

 
 

       
(a)      (b) 

 
(c) 

Figure 6.9  Orphan Mesh Part “GEODEF4-1”from Job-5 Output Database File (a), 
Corresponding Geometric Part “GeoDef5” (b,) and “GeoDef5” Remeshed (c) 
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(a)    (b) 

 

 
(c) 

Figure 6.10  Orphan Mesh Part “GEODEF5-1”from Job-6 Output Database File (a), 
Corresponding Geometric Part “GeoDef6” (b,) and “GeoDef6” Remeshed (c) 

 

  
(a)    (b) 

 
(c) 

Figure 6.11  Orphan Mesh Part “GEODEF6-1”from Job-7 output database file (a), 
corresponding geometric part “GeoDef7” (b,) and “GeoDef7” remeshed (c) 
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Figure 6.12 Orphan Mesh Part from Original Job-8 on  GeoDef7 using Pressure = 1 MPa 

 
A large deformation occurred between GeoDef7 (Figure 6.11(b)) and the orphan mesh part from 

Job-8, using a 1 MPa load as seen in Figure 6.12.  In this case, the approximate diameter of the cyst 

increased from 1.2 mm to 1.9 mm, over a 50 percent increase, which was deemed to be too large.  

Consequently, the  Job-8  analysis was rerun with a reduced pressure load from 1.0 MPa to 0.5 

MPa.  The resulting deformation is shown in Figure 6.13.  All subsequent pressure loadings were 

decreased to 0.5 MPa until further reductions were necessary.   

     
(a)    (b) 

 
(c) 
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Figure 6.13  Orphan Mesh Part “GEODEF7-1” from Reduced Pressure Load in Job-7 Output 
Database File (a), Corresponding Geometric Part “GeoDef8” (b,) and “GeoDef8” Remeshed (c) 

  
(a)     (b) 

Figure 6.14  Orphan Mesh Part “GEODEF8-1,” from Job-9 Output Database File (a) and 
Corresponding Geometric Part “GeoDef9” (b) 

 
 

 
Figure 6.15 Orphan Mesh Part from Original Job-10 on  GeoDef9 using Pressure = 0.5 MPa  

 

A large deformation occurred between GeoDef9 (Figure 6.14(b)) and the orphan mesh part from 

Job-10, using a  0.5  MPa load as seen in Figure 6.15.  The longest length of the cyst almost 

doubled in length as a result of this pressure, so the  Job-10  analysis was rerun with a reduced 

pressure load from 0.5  MPa to  0.2 MPa.  The resulting deformation is shown in Figure 6.16.  All 

subsequent pressure loadings were decreased to 0.2 MPa until further reductions were necessary.   
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(a)    (b) 

 
(c) 

Figure 6.16 Orphan Mesh Part “GEODEF9-1,” from Job-10 Output Database File (a), 
Corresponding Geometric Part “GeoDef10” (b,) and “GeoDef10” Remeshed (c) 

 

 
Figure 6.17 Resulting Aneurysm from Initial Job-11on GeoDef10 using Pressure Loading of 0.2 

MPa 
As seen in Figure 6.17, an aneurysm-like formation resulted from too large of a pressure load.  As 

a result, Job-11 on GeoDef10 was rerun using a reduced pressure of 0.1 MPa, shown in Figure 

6.18. 
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(a)     (b) 

Figure 6.18 Orphan Mesh Part “GEODEF10-1,” from Job-11 Output Database File using a 
Pressure Load of 0.1 MPa (a) and Corresponding Geometric Part “GeoDef11” (b) 

 

  
(a)     (b) 

Figure 6.19 Orphan Mesh Part “GEODEF11-1,” from Job-12 Output Database File (a), 
Corresponding Geometric Part “GeoDef12” (b), and “GeoDef12” Remeshed (c) 

 

    
(a)     (b) 

Figure 6.20 Orphan Mesh Part “GEODEF12-1,” from Job-13 Output Database File (a) and 
Corresponding Geometric Part “GeoDef13” (b) 
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Comparing cyst diameters in Figures 6.18, 6.19, and 6.20, the approximate diameters found are 

2.86 mm, 2.82 mm, and 2.83 mm, respectively, indicating the cyst diameter will stay about the 

same if more steps of 0.1 MPa pressure loadings are applied, while larger pressures appear to lead 

to aneurysm like failures.  As a result, an approximate diameter of 2.8 mm is taken as the limit of 

this analysis and Part GeoDef13 is assumed to be the final deformation.   

 

6.3.2 Strain 

The final deformed cyst can be approximated as a circle.  Using the query tool, it was found that 

the approximate diameter of the final deformation of the cyst was 2.825. This results in an 

approximate circumference of 6.268 mm.  Since the initial undeformed cyst was drawn with a 

cross sectional radius of 0.09 mm, the initial circumference of the cyst is 0.5655 mm.  The true 

strain, as typically used in large deformation, is given by Equation 6.1.   

Strain = ln(Cd/C)        (Equation 6.1)) 

Where  

Cd = Circumference of the deformed cyst  

C = Circumference of the cyst before deformation 

Strain = ln(6.268mm/0.5655mm) = 2.41 

Therefore, the true strain obtained using manual adaptive remeshing in this method 2.41.    

 
6.4 Discussion and Conclusions 
 
This method of Using Iterative Remeshing by Creating a Geometric Model from a Deformed 

Orphan Mesh to Allow for Large Deformation in ABAQUS  exhibits great potential as an effective 

and straight forward procedure to model the propagation of an IGC in an afflicted nerve.  The 

initial model and final propagation are shown in Figure 6.21. 
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(a)       (b) 
Figure 6.21  Initial Geometric FE Model (a) and Final Iteration using a Geometric Model from 

Deformed Orphan Mesh (b) 
 

This method is effective for all mesh types using two-dimensional elements and allows for further 

analyses to be conducted using orphan meshes, without being confined by their typical restrictions. 

Similarly to the triangular remeshing, user discretion is required to determine the appropriate 

pressure and mesh size per step.   A 2.41 true strain was obtained using this method over 13 

iterative steps,  displaying a strain  greater than the 2.26 and 2.06 strains obtained using an Eulerian 

approach due to cyst blow out and using EFGM, respectively (Soman 2011).   The final deformed 

shape of an IGC in an affected nerve is shown again in the MRI  (a) and the final deformation of  in 

the FEM using the geometric remeshed method (b) are shown in Figure 6.22.  As in the triangular 

remeshing model, similarities are apparent between these images as well,  notably the large round 

cyst surroundeded by a narrow nerve layer on left hand side of the FEM model and in the white 

cyst in the MRI indicated by an arrow.  Once again as mentioned with the triangular remeshing 

method, it is assumed that with actual contraints resembling the bone and tendons surrounding the 

nerve, a closer resemblance to the MRI would be obtained.  Additionally, further refinement in 

more iterations using much smaller pressure loadings and finer mesh size would presumably lead 

to greater expansion of the cyst with a thinner section of nerve material outlining the cyst.   The 

final deformation in Figure 6.20 (b) is assumed to be the final deformation for the purposes of this 
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research.  These further improvements are not within the scope of this report as the ultimate  intent 

of this research is to explore this method as an option. 

        

 

(a)       (b) 

Figure 6.22  Cross Section of Afflicted IGC Nerve MRI (a) and Propagated Cyst in FEM using 

Geometric Remeshing (b) 

One negative aspect to this method is that modeling errors due to large mesh size and sharp edges 

or other geometric concerns can be propagated and amplified over the course of the iterations as 

seen in Figure 6.23.  In this preliminary testing of the geometric method explained in this section, 

five iterations of 1 MPa each were applied to the center cyst, and fixed boundary conditions were 

fixed at the upper left and lower right corners, with jagged deformation resulting at these points.  A 

coarse mesh will be visible in the extracted geometric part in this method.  In the case of the cyst 

analysis, a coarser mesh was used in the early first two iterations.  The visible coarse mesh on the 

geometric part is smoothed out over the following 11 steps.  Conversely, while a finer mesh will 

create a better geometric part, the finer the mesh, the easier this mesh is distorted, so a larger 

number of iterative steps will be required to allow for the same overall deformation.  In this vein, 

another negative aspect of this technique is the large number of parts that it requires, with 27 parts 
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created in this analysis.  However, overall, the nerve geometry does not contain sharp corners or 

harsh geometry for modeling, and it remains a simple technique despite the resulting large 

collection of parts required.   

 
 

Figure 6.23 Propagated and amplified modeling errors in preliminary testing 
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8.  Conclusions 

Both methods of using iterative triangular mesh refinement for large deformation and of using 

iterative remeshing by creating a geometric model from a deformed orphan mesh for large 

deformation appear to be effective methods of using Lagrangian meshes for large deformation 

suitable for modeling of IGC propagation in the CPN.  Both methods exhibit similarities to the 

deformated shape of a cross sections of afflicted IGC nerve from clinical images, with potential for 

closer resemblances.  Additionally, both methods of manual adaptive remeshing in ABAQUS 

were able to provide greater true stains greater than 2.4, which is greater than with other methods 

previously explored in modeling this cyst propagation.   
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8.  Future Work and Suggestions 

In future work, it is suggested that manual adaptive remeshing procedures include more 

purposeful rules or guidelines for mesh sizing and pressure loads during steps to ensure that mesh 

distortion is within an allowable limit.  Additionally, this would optimize these procedures to 

minimize the number of steps required to achieve a deformation and would also add consistancy 

within these steps.  Applying smaller loads and finer meshes in additional iterations of remeshing 

will allow for further deformation, more consistent with an afflicted nerve.   

Improvements can be made with the Finite Element model itself, including the use of 

structured meshing (with the geometry method only) in order to more appropriately model the 

geometry of the nerve and cyst.  Additionally, adding boundary conditions and constraints 

consistent with the anatomy of the nerve and its surroundings, such as bone, will allow for more 

realistic deformation of the intraneural ganglion cyst.  Additionally, modeling with a an 

incompressible hyperelastic material will allow for mechanical modeling of parameters other than 

only strain.  However, the steps of the iterative remeshing may require different material properties 

based on the deformation to the material prior to that step.   

Finally, it is suggested to further explore ABAQUS’s adaptive remeshing technique of 

mesh-to-mesh solution mapping as this method is most similar to the manual adaptive remeshing 

explored in this report, but also has potential to retain the information from the initial mesh and to 

work with only one part using multiple steps.   
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Appendix A: Detailed Instructions on Using Iterative Triangular Mesh Refinement for 

Large Deformation in ABAQUS 6.9 

Note that the order of many of the steps within each analysis may be switched, but all steps must be 
completed. 
 
Part 1:  Initial Analysis 

1. Create Part 

a. Import sketch of nerve cross section into model and save as “CPN.” 

b. Create 2D Planar, Deformable, Shell Part, as Seen in Figure A.1.  

 
Figure A.1  Window to create part 

c. Add “CPN” sketch by clicking on the Add Sketch button and selecting “CPN” as 
seen in Figure A.2. 

 
Figure A.2 Add Sketch Dialog Box 
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d. Draw in circle for articular branch of 0.09 mm radius. 

 

 
Figure A.3 Final Sketch of Cross Section for Shell Planar Part 

The final part is seen in Figure A.3. 
2.  Seed Part  

a. Select the Mesh bin, and then Seed>Part as shown in Figure A.4. 

 
Figure A.4  Screenshot of seeding part 

b. Select an approximate global size of 0.1. 
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Figure A.5: Selection of approximate global size 

 
 

3.  Select a “Tri” element shape for meshing. 

a. Select Mesh > Controls. 

b. Select “Tri” as the element shape.  A free meshing type is automatically selected as 
the only available meshing technique for this element shape.   

 

 
Figure A.6  Mesh Controls Dialog Box 

4. Select Element Type of CPS3, a three-node linear plane stress triangle. 

a. Select Mesh>Element Type. 

b. Select Standard, Plane Stress, Linear, Tri, and use other preselected choices as 
seen in Figure A.7. 
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Figure A.7  Selection of Element Type 

 
5. Mesh the part. 

a. Select Mesh > Part 

This will result in part as seen in Figure A.8. 

 
Figure A.8  Mesh Cross Section of Nerve with CPS3 elements. 

 
6. Add a node set. 

a. Double click on the set bin under the created part.  Select two nodes on the right 
hand edge of the node as seen in Figure A.9.   
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Figure A.9  Selected Node Set 
7.  Create Surface. 

a.  Double click on the surface bin under the part.  Create a geometric surface by 
selecting the surface of the hole.   

8. Create a Pressure Step. 

a. Double click on the step bin to create a new, static general step after the Initial step 
as seen in Figure A.10.   

 

 
Figure A.10 Create Pressure Step Dialog Box 

9.  Create Nerve Material. 

a. Create an elastic isotropic material with Young’s modulus equal to 4.6 MPa and 
Poisson’s ratio equal to 0.3 as seen in Figure A.11. 
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Figure A.11  Nerve Material Dialog box 

  
10. Add section assignment to part.   

a. Select the nerve material created for the entire part as seen in Figure A.12. 

 
Figure A.12  Material Selection for Part 

 
11. Create instance for part. 

a. Double click the Instance bin under Assembly and select the part as seen in Figure 
A.13. 
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Figure A.13  Create Instance for Part Dialog Box 

12.  Create Pressure Load 

a. Create a Mechanical, Pressure Load for the Pressure Step as seen in Figure A.14. 

 
Figure A.14:  Create Load Dialog Box 

b. Select the surface previously created on the hole. 
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Figure A.15  Location of Pressure Loading 

c.  Add an initial load of 2 MPa.   

13.  Create Fixed Boundary Condition.   

a. Double click on the Boundary Condition bin and select the Initial step, and create a 
mechanical, displacement/rotation boundary condition as seen in Figure A.16. 

 

 
Figure A.16:  Create Boundary Condition Dialog Box 

b. Select previously created Node Set. 

c. Fix the Displacement in the U1 and U2 directions as seen in Figure A.17.  This will 
fix movement at the node set in the plane of the cross section.   
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Figure A.17 Edit Boundary Condition Dialog Box 

14.  Create a Job for the model as seen in Figure A.18. 

 
Figure A.18  Dialog Box for Create Job 

 
15. Submit Job. 

a. Right click on Job-1 and select Submit. 

 
16.  Initial deformation results. 

At this point, the first iteration of deformation is completed.  If excessive deformation occurs, 
it is necessary to lower the applied pressure in the cyst.  If the user believes that more 
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deformation can occur, the load can be increased.  Similarly, mesh size and the fixed node sets 
can be adjusted as deemed necessary by the user.  The deformed part is seen in Figure A.19. 

 
Figure A.19:  Initial Deformed Part 

Part 2:  Iterative Steps 
Once the initial analysis is run, the following iterative steps can be completed until the desired 
deformation is reached.   

1. Import deformed orphan mesh from output database file from previous job. 

a. Select File>Import>Part>jobname.odb, where jobname is the name of the 
previous job. The corresponding dialog box can be seen in Figure A.20.   

b. Select the instance used in the previous job, noting that all instances will be listed. 
In these instructions, the imported deformed part is saved as the default name of the 
selected instance.   

c. Check  Import deformed configuration to import deformed part.  
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(a)        (b) 

Figure A.20  Create Part from Output Database Dialog Box with single instance 
(a) and multiple instance (b)   

2. Delete extra sets. 

a. Extra sets not created by the user should be deleted as they were created as part of 
the orphan mesh. 

3. Refine Mesh. 

a. Select Mesh>Edit 

i. Select Refinement for the Category and Set Size for the Method.   

ii. Select a new mesh size.  In this case, 0.1 was used. 

iii. Select Remesh for the method.  Remesh part.  The remeshed part is shown 
in Figure A.21.   
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Figure A.21  Remeshed Part after Refinement 

4. Edit node set and surface. 

Since the mesh has been altered, the node set and surface are no longer valid as seen in Figure A.22 
and must be edited.   

 
Figure A.22  Sets and surfaces are no longer valid after mesh refinement. 

a. Edit node set and select two nodes on the right hand edge of the part.  

b. Edit surface set and select an element surface of cyst. 

5. Section assignment 

a. Make section assignment of nerve material to new part in its entirety.   

6. Instance 

a. Create a new instance on new part. 
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Figure A.23  Create Instance Dialog Box with Multiple Parts 

7. Edit Boundary Conditions and Loads with appropriate instances. 

a. Instances must be selected from current part for both fixed boundary condition and 
loads as seen in Figure A.24. 

 
Figure A.24  Selection of correct surface for applied pressure load.   

b. Loads may need to be decreased if deformation is too great.   

8. Create a new job. 

9. Run job. 

10. Repeat steps 1 through 9 from the iterative steps until desired deformation is achieved.   
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Appendix B:  Detailed Instructions on Using Iterative Remeshing by Creating a Geometric 
Model from a Deformed Orphan Mesh to Allow for Large Deformation in ABAQUS 6.9 
 
Note that the order of many of the steps within each analysis may be switched, but all steps must be 
completed. 
 
Part 1: Initial Analysis 
1.  Create Part 

a. Import sketch of nerve cross section into model and save as “CPN.” 

b. Create 2D Planar, Deformable, Shell Part, as seen in Figure B.1.  

 
Figure B.1 Window to create part 

c. Add “CPN” sketch by clicking on the Add Sketch button and selecting “CPN” as 
seen in Figure B.2. 

 
Figure B.2 Add Sketch Dialog Box 
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d. Draw in circle for articular branch of 0.09 mm radius. 

 

 
Figure B.3 Final Sketch of Cross Section for Shell Planar Part 

 
The final part is seen in Figure B.3. 
 

2. Create Nerve Material. 

a. Create an elastic isotropic material with Young’s modulus equal to 4.6 MPa and 
Poisson’s ratio equal to 0.3 as seen in Figure B.4. 
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Figure B.4 Material Dialog box 

 

3. Create a Nerve Section. 

a. Select a Solid, Homogeneous Section for the Nerve material. 

           
Figure B.5 Create Section Dialog Box 

 
4.  Create Section Assignment for entire part using this Nerve Section 

5. Add section assignment to part.   
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a. Select the nerve material created for the entire part as seen in Figure B.6.   

 
Figure B.6 Material Selection for Part 

 

6. Mesh Part.   

a. Select Quad Dominated Mesh Type if not already selected. 

• Mesh>Controls 

b. Select Element type of Standard, Linear, Plane Stress, Quad, Reduced Integration, with 
Hourglass Control, or other plane stress element.  In this case, CPS4R, a 4-node 
bilinear plane stress quadrilateral, reduced integration, hourglass control element was 
chosen as shown in Figure B.7. 

 
Figure B.7 Selection of Element Type 

 
c.  Seed Mesh. 
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i. Choose an approximate global seed size of 0.1. 

 
Figure B.8 Selection of Global Seeding Size 

d. Mesh Part. 

i. Select Mesh>Part. 

The resulting meshed part is shown in Figure B.9. 

 
Figure B.9 Meshed Part 

 
7.  Create Node Set. 

a. Select 2 nodes on the far right hand side of the nerve to prevent rigid body motion 
as shown in Figure B.10. 
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Figure B.10 Selection of Fixed Node Set 
 

8.  Create Geometric Surface of Cyst as shown in Figure B.11 (a) and (b). 

          
Figure B.11 Create Surface Dialog Box (a) and Selected Surface (b) 

 
9.  Create Instance on Part by selecting entire part. 

10. Create Step (Pressure Step) 

a. Choose Static, general step after Initial Step as displayed in Figure B.12. 
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Figure B.12 Create Step Dialog Box 
 

11.  Create Load 

a. Create a mechanical, pressure to Pressure Step 

b. Apply this pressure to the created surface as shown in Figure B.13.  

 

Figure B.13 Selection of Surface for Applied Pressure Loading 

 

c. Apply a uniform pressure; in this case of magnitude 1 MPa, ramp amplitude as 
shown in Figure B.14.   
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Figure B.14 Edit Load Dialog Box 

12.  Create a Boundary Condition for the Initial Step on the fixed node set. 

a. Use a mechanical, displacement/rotation step for the previously created node set as 
shown in Figure B.15. 

 

4.                                (b) 

Figure B.15 Create Boundary Condition Dialog Box (a) and Region Selection for 

Condition (b) 
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b. Fix this node set in the x and y directions as shown in Figure B.16. 

 
Figure B.16 Edit Boundary Condition Dialog Box 

13.  Create Job-1 and submit. 

The results for this job-1 analysis are seen in Figure B.17 below. 

 

 
Figure B.17 Job-1 Results of deformed and undeformed shape 

 
14.  Import deformed .odb file. 

a. File>Import>Part. 

b. Select Job-1.odb.  Select the appropriate instance and select deformed 
configuration as shown in Figure B.18. 
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Figure B.18 Create Part from Output Database Dialog Box 
 

c. The features of this part will be an orphan mesh without associated geometry.  The 
node set and surface will be propagated from the original part, and other sets will 
have been created.   

15. Create 2D Geometry from Orphan Mesh Part. 

a. Click on the command window at the bottom of the screen as located in Figure 
B.19. 

 
                            Figure B.19:  Command Line Window 

b. Type the following in the command line: 

NewPart=mdb.models[‘Model-1’].parts[‘NERVE-1’] 
GeoDef1=mdb.models[‘Model-1’].Part2DGeomFrom2DMesh(name = 

‘GeoDef1’,part=NewPart,featureAngle=0) 
Where “Model-1” is the name of the model, “NERVE-1” is the name of the orphan meshed part, 

and “GeoDef1” is the name of the new geometric part being created from the meshed part.   
The following geometric part will result as shown in Figure B.20. 
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Figure B.20: Geometric Part named GeoDef1 

This part’s features are shell-planar from a section sketch from the deformed mesh in part 
“NERVE-1.”  The “FIXED NODE SET” from the original part “nerve” and the deformed orphan 
mesh “NERVE-1” is carried to part “GeoDef1,” but surfaces, meshes, and section assignments are 
now empty.   
 
 
 
Part II: Iterative Steps  
  

16.  Create a new cyst surface on the cyst hole (Figure B.21) 

    
Figure B.21Create Surface Dialog Box(a) and Location of surface in red (b) 

 
 

17.  Add Section Assignment (Step 4). 

18. Seed and Mesh Part (Step 6).   

19. Create New Instance on GeoDef1 as seen in Figure B.22 (a) and (b) 
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Figure B.22 Create Instance Dialog Box with Multiple Parts (a) and Selected Part (b) 

20.  Edit Region for Load to Fixed Node Set for Part GeoDef1 as seen in Figure B.23. 

5.  

6. Figure B.23 Selection of Fixed Node Set from New Geometric Part 

21. Edit Region for Load to Cyst Surface for GeoDef1 (Figure B.24).   
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Figure B.24 Region Selection Dialog Box 

22. Create Job-2 and submit job. 

23. Repeat Steps 14 through 22 until desired deformation is acquired.   

 

It is important to ensure selection of appropriate instances when importing *.odb files and 
applying loads and boundary conditions to parts.   

 


	Use of manual adaptive remeshing in the mechanical modeling of an intraneural ganglion cyst
	Recommended Citation

	USE OF MANUAL ADAPTIVE REMESHING IN THE MECHANICAL MODELING OF AN INTRANEURAL GANGLION CYST
	Mechanical Engineering
	Report Advisor _________________________________________   Dr. Gregory Odegard
	Department Chair _________________________________________   Dr. William Predebon
	Date ________________________________________
	1.1.2  Nerve Anatomy and Intraneural Ganglion Cysts
	1.1.3  Articular (Synovial) Theory
	1.3  Manual Adaptive Remeshing
	4.2.1  Manual Adaptive Remeshing Overview
	4.2.2  Exporting Deformed Meshes
	Deformed parts can easily be imported as a part back into ABAQUS.  However, this imported part is in the form of an orphan mesh, which means that it contains no geometry and is dependent on its deformed mesh.  This is done by running the analysis (in ...
	4.2.5  Converting Orphan Mesh to Geometry
	5. Using Iterative Triangular Mesh Refinement for Large Deformation in ABAQUS




